
Internet Marketing
Make Money Online

by William Tan (WillTan.com)



What This Course Is NOT ABOUT

● Income or success guarantee
● Earning 4 or 5 figure income starting next month

● Firing your boss
● Giving you the “fish”
● “ITE"



What This Course Is ABOUT

● AWARENESS : A - Z in Internet Marketing
● Level : Beginner → Intermediate

● Having an ENTREPLOYEE (Time Management) mindset
● Acquiring core web development skillsets - administration and 

maintenance of your own website(s)

● LEARNing and DOing

● Taking massive small (but consistent) actions

● Asking questions (being interactive)



Logistics

● Start time :  6.45pm

● Sign your attendance ← IMPORTANT (COA)

● Update your contact - https://bit.ly/imclassreg 

● Break : 5 min (~8.15pm)

● Q&A : 15 min (before 9.30pm - 9.45pm)

● Practice (homework)

● Support @ https://willtan.com/support 
P.S. The above ticketing system is the ONLY support channel. No support will be warranted via email, 
WhatsApp or phone call. All tickets will be answered within 2-4 business days. 

https://bit.ly/imclassreg
https://willtan.com/support


Power Of The Internet

• Internet is the largest communication media.

• Internet is an unique media. It levels the playground and makes 
everyone equal. Anyone with the right knowledge and skill can start an 
online business to make money.

• No one, be it for personal or business, can afford to miss the Internet 
Opportunity.

• Bill Gates : There are only 2 types of business …

1st : Either your business is online or

2nd : ___________________________________

•



Power Of The Internet

• How many active domain names are there?

https://research.domaintools.com/statistics/tld-counts/  

• How many internet users are there?

https://www.statista.com/statistics/325706/global-internet-user-pen
etration/ 

https://research.domaintools.com/statistics/tld-counts/
https://www.statista.com/statistics/325706/global-internet-user-penetration/
https://www.statista.com/statistics/325706/global-internet-user-penetration/


Power Of The Internet

• How do you get your potential customers to know you online?

• Wikipedia :

Internet marketing, also referred to as online or digital marketing, is 
marketing using the Internet.

Internet marketing strategy includes all aspects of online advertising 
products, services, and websites, including search engine marketing, 
public relations, social media, market research, email marketing, and 
direct sales.



Power Of The Internet

● Fundamentals of Internet Business :

● In a bricks-n-mortar business, the main keys to success are location, 
location and location.

● For an online business, the keys to success are __________, ___________ and 
____________.

Unique Selling Proposition (USP)
Answer this! – “Why must I buy from you?”



Creativity ∝ Success



Creativity ∝ Success

● Post-It ® Notes were invented by accident.

● Dr Spencer Silver was working at 3M trying to create super strong 
adhesives.

● Instead, Silver created an incredibly weak, pressure sensitive adhesive 
which 3M management perceived it as “failure”.

● The project was shelved for years until Art Fry (3M Product 
Development Engineer) conceived the Post-It Notes idea.

● Post-It ® (and related technologies) achieved phenomenal success till 
these days.



Internet Success

https://del.icio.us/ 

https://del.icio.us/


Internet Success



Internet Success



Internet Success

https://www.lovebonito.com 

https://lovebonito.com


Monetisation Methods

● Pay-per-click (PPC) ie. AdSense

● Affiliate Marketing

● Info-products ie. ebooks, software, plugins, e-courses etc.

● eCOM - selling physical merchandise

● Services ie. web design, SEO, massage, coaching etc.

● Advertising ie. high traffic websites/blogs, solo-ads etc.

● Flipping … and more ...

● What (should be)/is/are your FOCUS(es)?



Google AdSense

https://cheques-gallery.blogspot.sg/

https://cheques-gallery.blogspot.sg/


Google AdWord



Google Network

Google

AdSense

AdWords

Advertisers

PPC/SE

Publisher

$4

$2
Traffic

Keywords



Tips To Get Your AdSense Account

● Use Gmail to apply. Do not use Yahoo! Mail or Hotmail.

● How/where to apply for AdSense?

● Read the Terms - 
https://www.google.com.sg/intl/en/policies/terms/regional.html

● The pros and cons about AdSense.

● Apply via Blogger and YouTube.

https://www.google.com.sg/intl/en/policies/terms/regional.html


Keyword Analysis

● One of the most important steps in Internet Marketing.

● Equivalent to business feasibility study or research before you actually 
start a business.

Is there a market?
How big is your potential customer base online?
Who are you (online) competitors?
Are you better in price / quality / service?
What is your marketing plan?
How much start up capital to you have?
What if it don’t work out?

WHAT / HOW / WHEN / WHICH / WHO / WHY / WHERE



Keyword Analysis

● Keyword analysis is the fundamental of search engine optimization (SEO).

● It determines your ROI and profitability.

● Take your time and effort to do Keyword Analysis.
● Keyword Analysis Tools :

○ Market Samurai (http://www.marketsamurai.com/) 

○ Long Tail Pro (https://longtailpro.com/) 

○ Keyword Planner (BEST & FREE tool from Google!)

○ Ubersuggest (https://neilpatel.com/ubersuggest/) 

● Focus to rank in Google – Google got the highest share in the search 
engine market.

http://www.marketsamurai.com/
https://longtailpro.com/
https://neilpatel.com/ubersuggest/


Keyword Planner

• Create your Google Account (if you do not have one)
• Go to https://adwords.google.com.sg/KeywordPlanner
• Create an account
• Click “Skip the guided setup” ← IMPORTANT
• Enter your details; select the right currency
• AdWords > Tools > Keyword Planner
• Video (0:26-second) - https://bit.ly/createadwords 
• https://willtan.com/perform-proper-site-keyword-analysis-seo/

https://adwords.google.com.sg/KeywordPlanner
https://bit.ly/createadwords
https://willtan.com/perform-proper-site-keyword-analysis-seo/


Keyword Analysis (2 Tandem Steps)

• Is there a demand? (Volume / Searches)

• How many searches are there on your keywords?

• https://neilpatel.com/ubersuggest/ 

• Competitiveness of your keywords?

• How many ACTUAL competitors do you have?

• https://google.com > intitle:“keyword”

• Key to success : Low competition & High search volume

https://neilpatel.com/ubersuggest/
https://google.com/
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Keyword Analysis (2 Tandem Steps)

● Key to success : Low competition & High search volume

● Your keywords/niches :

1. ____________________________________

2. ____________________________________

3. ____________________________________



Domain Name

• Now that you have done your Keyword Analysis, next is to get the right 
domain name. 

• Example : www.make-money-online-101.com; www.ezfax.com.sg; 
willtan.com

• Domain registrar :

• https://WillTan.com/namecheap (aff link)

• ~$10 per year.

• Search for “namecheap discount code jan 2019” for discount codes.

• https://www.sgnic.sg/list-of-registrars.html

http://www.make-money-online-101.com/
http://www.ezfax.com.sg
https://willtan.com
https://willtan.com/namecheap
https://www.sgnic.sg/list-of-registrars.html


Web Hosting

• cPanel with “One-Click” Software Installer, PHP, Linux-based, unlimited 
mySQL databases, 24/7 support, 99.9% SLA etc.

• ~$5-10 per month.

• https://WillTan.com/hosting (highly recommended; aff link)

If you acquire hosting via the above link, let me know via 
https://willtan.com/support to enjoy :

• Premium themes and plugins 
• Insider webmastering support

https://willtan.com/hosting
https://willtan.com/support


Domain Name & Web Hosting



Domain Name & Web Hosting

Domain Name

Where to buy/acquire?

How much?

What must you do?
Update Nameservers (of hosting)

Web Hosting

Where to buy/acquire?

How much?

What must you do?
Update/Add-on domain(s) 

1 2

3



Useful Web Resources

● Web templates – https://www.TemplateMonster.com

● Premium WordPress themes - Elegant Themes, Thrive Themes, 

Theme Forest etc.

● Stock pictures (photos) – https://fotolia.com, https://123rf.com

● Icons and graphics : https://pixabay.com, https://pexels.com, 
https://stocksnap.io, https://iconfinder.com, https://iconarchive.com etc.

● Marketing media : https://media.willtan.com 

● Online graphic editor – https://pixlr.com, GIMP.org etc.

● Screen recorder - VSDC Free Video Editor, Camstudio.org etc.

https://www.templatemonster.com/
https://willtan.com/thrivethemes
https://themeforest.net/
https://fotolia.com/
https://123rf.com
https://pixabay.com
https://pexels.com
https://stocksnap.io
https://iconfinder.com/
https://iconarchive.com/
https://media.willtan.com
https://pixlr.com


Web Development Platforms

● Free Hosting – Blogger.com, Google Sites, WordPress.com, Wix.com, 
Weebly.com, Hubpages.com, Tumblr.com, socials etc.

● Paid Hosting : (cPanel’s “1-click Installer”)

■ WordPress (WordPress.org)

■ Joomla (Joomla.org)

■ Drupal (Drupal.org)

■ Magento (Magento.com)

■ etc.



WordPress Development (Practice)

● Sign up a FREE account at HybridECOM.com

● Click “Join Now!”

● Select the BASIC (Free!) Plan

● Select one of the Template Sites (you’ll see only 1 template for now)

● Site Title : ie. William Tan (put your name)

● URL : ie. willtan (lowercase; no spacing; your final URL will looks like 
https://hybridecom.com/willtan)



WordPress Development (Practice)

● Username : ie. willtan (lowercase; no spacing)

● Email : (ie. your Gmail)

● Password : (set your own password; remember it!) 

● Confirm your password

● CREATE ACCOUNT

● Log in to your WordPress Dashboard



WordPress Development (Practice)

● Appearance > Themes > GeneratePress > Activate

● Plugins > GP Premium > Activate

● Appearance > Themes > GeneratePress > Site Library > Marketer > 
Details > Get Started > Backup Options (ignore the json download) > 
Import Options > Check “I understand …” > Import Content > Visit Site

 

● The trade secret formula for learning WordPress ....



Case Studies

● https://sgmylive.com - Sg My LIVE app - Causeway Traffic

● https://willtan.com - Personal/niche site

● https://willtan.com/learn - eLearning Portal

● https://dev.willtan.com - Web Services

● https://media.willtan.com - Marketing Media

● https://homesweeter.com - eCOM store; Home products

● https://painreliefmart.com - eCOM store; Pain relief products

● https://webapppage.com - WP plugin

● https://smartlearn.sg - LMS portal

https://sgmylive.com
https://willtan.com
https://willtan.com/learn
https://dev.willtan.com
https://media.willtan.com
https://homesweeter.com
https://painreliefmart.com
https://webapppage.com
https://smartlearn.sg


Content Generation

● Content is KING!
● Write It Yourself – Advantage : unique & personalized; Disadvantage : time 

consuming

● “Copy”writing – https://ezinearticles.com etc.

● Article Spinner - https://willtan.com/spinner 

● Curated contents ie. news.google.com, News @ SgMyLIVE.com

● Outsource : https://warriorforum.com, https://WillTan.com/contents (aff 
link) etc.

● Checking copyrights – https://copyscape.com

https://ezinearticles.com/
https://willtan.com/spinner
https://warriorforum.com/
https://willtan.com/contents
https://copyscape.com/


Affiliate Marketing

• Affiliate Marketing is one of the FASTEST (and one of the best) methods to 
make money online.

• An affiliate program is set up by a website owner who is selling a product 
or service.

• The advantages of affiliate marketing :

You do NOT need your own website.
You do NOT need your own product or service.
No inventory to keep.
No shipping and logistic.
No helpdesk needed. No angry customer.
You do NOT have to worry about anything except advertising.



Affiliate Marketing

• All you need to do is to recommend and promote other people products or 
services, and you will earn a commission, usually 50% or more, each time 
someone you referred to their website (through your affiliate URL) made a 
purchase/sale.

• Join an affiliate program/network
• Advertise/promote your affiliate links
• Collect your commissions



Affiliate Networks

• To ensure receipt of payment, join only reputable affiliate networks :



Affiliate Marketing

● https://www.jvzoo.com > Register an account (FREE SIGNUP)

● Verify and log in to your JVZoo account

● Dashboard > Affliates > Find Products

● MunchEye.com - IM product launches

● Is the landing page well crafted?

● Is it still with the affiliate network? (Using the right payment gateway)

● Refund and money-back

● Sales funnel - OTO(s), recurring etc.

● Trustworthiness - building your authority

https://www.jvzoo.com


e-Business Models

● Affiliate - No money down; lowest risk
● Dropshipping - Moderate risk; key is in your dropship suppliers
● Light-bulk / Trading - High capital; high risk; higher margin
● OEM / ODM - High capital/risk; key is in branding/quality; ownership

● To avoid : - Rental (offline)

- Expiry (products void when reaching expiry)

- Consumable* (QA)

- Branded name (legality issues)



Traffic Generation

● Traffic is the essential key to online success.

● You can have the best looking professional websites or blogs with the best 
products or services … BUT, if there is NO traffic to your site/blog that you 
can successfully monetize, then there will be NO earnings.

● So how do you keep track of your traffic statistic?

● Google Analytics (https://analytics.google.com) 

● cPanel’s AWStats ie. yourdomain.com/cpanel

https://analytics.google.com


Traffic Generation

● PPC Advertising (most targeted traffic)

● AdWords (https://adwords.google.com) - BEST!

● Other : Yahoo!, MSN etc.

● Forums (where actual buyers are)

● Warrior Forum (https://warriorforum.com) 

● Niche forums : https://singaporemotherhood.com, 
https://www.sgcarmart.com, https://www.hardwarezone.com.sg etc.

https://adwords.google.com
https://warriorforum.com
https://singaporemotherhood.com
https://www.sgcarmart.com
https://www.hardwarezone.com.sg


Traffic Generation

● Linking (SE #1 criteria)

● A long-term continuous task after web development

● SEO/SERP – What the spider think of you?

● Outsource linking campaigns @ WF

● Social Marketing (power of social media/sharing)

● Top social medias : Facebook, Twitter, LinkedIn, Google+, YouTube, 
Instagram, Pinterest ...  etc.

● Automation : ie. https://wordpress.org/plugins/wp-to-buffer/ 

https://wordpress.org/plugins/wp-to-buffer/


Traffic Generation

● Affiliate Program (Own products/websites)

● Leverage on 1% effort of 100 people (affiliates) instead of 100% of your 
own effort

● Joining affiliate network ie. JVZoo, WF, ClickBank etc.

● Content - Content is KING! 

● Ultimately, it’s for the humans and humans are traffic

● Stickiness / viral /  social networked

● Build trust/relationship; grow buyer lists



Traffic Generation

● List Building

● The money is in the lists! Why your lists are your most important assets?!

● Subscriber list is your true online asset!

● You will need an autoresponder (ESP; email service provider)

● Subscribe to WillTan.com Newsletters

● https://willtan.com/courses/autoresponder-2/ - Discount code : WSO

https://willtan.com/courses/autoresponder-2/


Ownership

• AdSense, Affiliate Marketing versus ...

• Creating your own products - ebooks, ecourses, software, services, plugins, 
themes, membership sites etc.

• Whoever owns the domain owns everything.

• Your own (online) assets ie. own e-businesses, own lists etc.

A simple blueprint : Start your own e-com site → Sell niche products → Grow 
your traffic → Build your lists → Generate quality contents → Ad campaigns 
→ Scaling up



When There’s Will, There’s a Way

• Information overload?
• Antidote : FOCUS & OUTSOURCE!

• The Bookstore Syndrome

• Keep learning & enjoy doing/earning

• Ultimate Support @ https://willtan.com/support 

• Learning/coaching - https://willtan.com/learn

• Facebook Page : https://facebook.com/internet.marketing.sg

• Resources : Fiverr, WarriorForum, Freelancer, UpWork etc.

    

https://willtan.com/support
https://willtan.com/learn
http://facebook.com/internet.marketing.sg

